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1 Ważne 
informacje 
dotyczące 
bezpieczeństwa

Ogólne zalecenia 
konserwacyjne
Tłumaczenie tej dokumentacji jest tylko do 
referencji. 
W przypadku różnic między wersją angielską 
a tłumaczeniem zastosowanie będzie miała 
wersja angielska.
 

Przestroga

Aby zapobiec uszkodzeniu lub wadliwemu  •
działaniu:
Nie narażaj produktu na działanie  •
nadmiernego ciepła wytwarzanego przez 
urządzenia grzewcze lub bezpośrednie 
działanie światła słonecznego.
Nie upuszczaj produktu i nie dopuść, aby  •
spadały na niego inne przedmioty.
Nie zanurzaj produktu w wodzie. Uważaj, aby  •
woda nie dostała się do gniazda słuchawek i 
komory baterii, gdyż może ona spowodować 
znaczne uszkodzenia.
Działanie telefonów komórkowych w pobliżu  •
urządzenia może spowodować zakłócenia. 
Rób kopie zapasowe plików. Koniecznie  •
zachowuj oryginalne pliki pobrane do 
urządzenia. Firma Philips nie ponosi 
odpowiedzialności za jakąkolwiek utratę 
danych spowodowaną uszkodzeniem 
lub brakiem możliwości odczytu danych 
zapisanych w urządzeniu. 
Aby uniknąć problemów, należy zarządzać  •
plikami (przesyłać je, usuwać itd.) tylko przy 
pomocy oprogramowania muzycznego 
dołączonego do zestawu!
Nie stosuj żadnych środków czyszczących  •
zawierających alkohol, amoniak, benzen lub 
materiały ścierne, gdyż mogą one powodować 
uszkodzenie produktu.

 

Temperatury eksploatacji i przechowywania
Urządzenia należy używać w • 
temperaturze 0–35ºC.
Urządzenie należy przechowywać w • 
temperaturze -20–45ºC.
W niskich temperaturach żywotność • 
akumulatora urządzenia może być 
krótsza.

 
Części zamienne i akcesoria:
Części zamienne i akcesoria można zamówić 
na stronie internetowej www.philips.com/
support.
 
Ochrona słuchu

Głośność dźwięku podczas słuchania powinna 
być umiarkowana:
Korzystanie ze słuchawek przy dużej głośności 
może spowodować uszkodzenie słuchu. Ten 
produkt może generować dźwięk o natężeniu 
grożącym utratą słuchu użytkownikowi ze 
zdrowym słuchem, nawet przy użytkowaniu 
trwającym nie dłużej niż minutę. Wyższe 
natężenie dźwięku jest przeznaczone dla osób z 
częściowo uszkodzonym słuchem.
Głośność dźwięku może być myląca. Z czasem 
słuch dostosowuje się do wyższej głośności 
dźwięku, uznawanej za odpowiednią. Dlatego 
przy długotrwałym słuchaniu dźwięku to, co 
brzmi „normalnie” w rzeczywistości może 
brzmieć głośno i stanowić zagrożenie dla słuchu. 
Aby temu zapobiec, należy ustawiać głośność na 
bezpiecznym poziomie, zanim słuch dostosuje 
się do zbyt wysokiego poziomu.
Ustawianie bezpiecznego poziomu głośności:
Ustaw głośność na niskim poziomie.
Stopniowo zwiększaj głośność, aż dźwięk będzie 
czysty, dobrze słyszalny i bez zakłóceń.
Nie słuchaj zbyt długo:
Długotrwałe słuchanie dźwięku, nawet na 
„bezpiecznym” poziomie, również może 
powodować utratę słuchu.
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Korzystaj z urządzenia w sposób umiarkowany 
oraz rób odpowiednie przerwy.
Podczas korzystania ze słuchawek stosuj się do 
poniższych zaleceń.
Nie słuchaj zbyt głośno i zbyt długo.
Zachowaj ostrożność przy zmianie głośności 
dźwięku ze względu na dostosowywanie się 
słuchu.
Nie zwiększaj głośności do takiego poziomu, 
przy którym nie słychać otoczenia.
W potencjalnie niebezpiecznych sytuacjach 
używaj słuchawek z rozwagą lub przestań ich 
używać na jakiś czas.
Nie używaj słuchawek podczas prowadzenia 
pojazdu silnikowego, jazdy na rowerze, 
deskorolce itp., gdyż może to spowodować 
zagrożenie dla ruchu ulicznego, a ponadto jest 
to niedozwolone na wielu obszarach.
 
Modyfikacje
Nieautoryzowane przez producenta 
modyfikacje mogą spowodować unieważnienie 
prawa użytkownika do korzystania z tego 
produktu.
 
Prawa autorskie
Wszelkie pozostałe marki i nazwy produktów 
stanowią własność poszczególnych firm i 
organizacji.
Nieautoryzowane kopiowanie jakichkolwiek 
nagrań pobranych z Internetu lub utrwalonych 
na płytach Audio–CD stanowi naruszenie praw 
autorskich i umów międzynarodowych.
Wykonywanie nieautoryzowanych 
kopii materiałów zabezpieczonych 
przed kopiowaniem, w tym programów 
komputerowych, plików, audycji i nagrań 
dźwiękowych, może stanowić naruszenie praw 
autorskich będące przestępstwem. Nie należy 
używać niniejszego urządzenia do takich celów.
Windows Media oraz logo Windows 
są zastrzeżonymi znakami towarowymi 
firmy Microsoft Corporation w Stanach 
Zjednoczonych i/lub innych krajach.
 

Zachowaj odpowiedzialność! Szanuj prawa 
autorskie.

Firma Philips szanuje własność intelektualną i 
oczekuje tego samego od użytkowników swoich 
produktów. 
Materiały multimedialne dostępne w Internecie 
mogą być tworzone i/lub rozprowadzane bez 
zgody właścicieli praw autorskich. 
Kopiowanie lub dystrybucja takich materiałów 
może naruszać prawa autorskie w różnych 
krajach, także w Twoim. 
Przestrzeganie praw autorskich jest Twoją 
odpowiedzialnością.
Nagrywanie i przesyłanie do przenośnego 
odtwarzacza strumieni wideo pobranych do 
komputera jest możliwe tylko w przypadku 
materiałów publicznych lub posiadających 
odpowiednią licencję. Materiałów takich można 
używać wyłącznie do użytku prywatnego, 
niekomercyjnego i należy przestrzegać instrukcji 
dotyczących praw autorskich dostarczonych 
przez właściciela danego materiału. Instrukcje 
takie mogą zabraniać wykonywania 
jakichkolwiek kopii. Strumienie wideo mogą 
zawierać technologie zabezpieczające przed 
wykonywaniem kolejnych kopii. W takich 
przypadkach funkcja nagrywania nie będzie 
działać, a użytkownik zostanie powiadomiony za 
pomocą komunikatu.
 
Rejestrowanie danych
Firma Philips dba o jakość oferowanych 
produktów, aby zapewnić swoim klientom 
jak najlepsze doświadczenia ich użytkowania. 
Dlatego w celu utworzenia przejrzystego 
profilu użytkowania tego urządzenia rejestruje 
ono niektóre informacje/dane w pamięci 
trwałej. Służą one następnie do identyfikacji i 
wykrywania wszelkich awarii lub problemów, 
które może napotkać użytkownik. Dane te 
to na przykład czas trwania utworu w trybie 
odtwarzania muzyki, czas słuchania radia, 
liczba rozładowań akumulatora, itp. Dane tego 
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rodzaju nie zawierają informacji na temat 
treści lub mediów zapisywanych w pamięci 
urządzenia lub źródła ich pochodzenia. Dane 
zapisane w pamięci trwałej są odzyskiwane i 
używane WYŁĄCZNIE w przypadku odesłania 
urządzenia do centrum serwisowego firmy 
Philips i TYLKO w celu łatwiejszego wykrycia i 
niedopuszczenia do powstania błędów. Zapisane 
dane zostaną udostępnione użytkownikowi 
bezzwłocznie na żądanie.
 
Monkey’s Audio decoder

a The Monkey’s Audio SDK and source 
code can be freely used to add 
APE format playback, encoding, or 
tagging support to any product, free 
or commercial. Use of the code for 
proprietary efforts that don’t support 
the official APE format require written 
consent of the author.

b Monkey’s Audio source can be included 
in GPL and open-source software, 
although Monkey’s Audio itself will 
not be subjected to external licensing 
requirements or other viral source 
restrictions.

c Code changes and improvements must 
be contributed back to the Monkey’s 
Audio project free from restrictions or 
royalties, unless exempted by express 
written consent of the author.

d Any source code, ideas, or libraries used 
must be plainly acknowledged in the 
software using the code.

e Although the software has been tested 
thoroughly, the author is in no way 
responsible for damages due to bugs or 
misuse.

If you do not completely agree with all of the 
previous stipulations, you must cease using this 
source code and remove it from your storage 
device.
 

FLAC decoder
Copyright (C) 2000,2001,2002,2003,2004,2005,
2006,2007,2008,2009 Josh Coalson
 
Redistribution and use in source and binary 
forms, with or without modification, are 
permitted provided that the following 
conditions are met:

Redistributions of source code must • 
retain the above copyright notice, this list 
of conditions and the following disclaimer.
Redistributions in binary form must • 
reproduce the above copyright notice, 
this list of conditions and the following 
disclaimer in the documentation and/
or other materials provided with the 
distribution.
Neither the name of the Xiph.org • 
Foundation nor the names of its 
contributors may be used to endorse 
or promote products derived from this 
software without specific prior written 
permission.

 
THIS SOFTWARE IS PROVIDED BY 
THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. 
IN NO EVENT SHALL THE FOUNDATION 
OR CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY 
OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING 
IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.
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XPAT XML Parser
Copyright (c) 1998, 1999, 2000 Thai Open 
Source Software Center Ltd
 
Permission is hereby granted, free of charge, to 
any person obtaining a copy of this software 
and associated documentation files (the 
“Software”), to deal in the Software without 
restriction, including without limitation the rights 
to use, copy, modify, merge, publish, distribute, 
sub-license, and/or sell copies of the Software, 
and to permit persons to whom the Software 
is furnished to do so, subject to the following 
conditions:
 
The above copyright notice and this permission 
notice shall be included in all copies or 
substantial portions of the Software.
THE SOFTWARE IS PROVIDED “AS IS”, 
WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR 
A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. IN NO EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS 
BE LIABLE FOR ANY CLAIM, DAMAGES 
OR OTHER LIABILITY, WHETHER IN AN 
ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR 
IN CONNECTION WITH THE SOFTWARE 
OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.

Recykling produktu
To urządzenie zostało zaprojektowane 
i wykonane z materiałów oraz komponentów 
wysokiej jakości, które nadają się do ponownego 
wykorzystania.
Jeśli produkt został opatrzony symbolem 
przekreślonego pojemnika na odpady, oznacza 
to, że podlega on postanowieniom dyrektywy 
europejskiej 2002/96/WE.

Nigdy nie należy wyrzucać tego produktu 
wraz z innymi odpadami pochodzącymi 
z gospodarstwa domowego. Należy zapoznać 
się z lokalnymi przepisami dotyczącymi utylizacji 
sprzętu elektrycznego i elektronicznego. 
Prawidłowa utylizacja starych produktów 
pomaga zapobiegać zanieczyszczeniu 
środowiska naturalnego oraz utracie zdrowia.

Ostrzeżenie

Produkty z niewymiennymi, wbudowanymi  •
akumulatorami: wyjęcie (lub próba wyjęcia) 
akumulatora powoduje unieważnienie 
gwarancji. Tę procedurę należy wykonać 
dopiero po zakończeniu okresu eksploatacji 
produktu. 

Produkt zawiera wbudowany akumulator 
opisany w treści dyrektywy 2006/66/WE, 
którego nie można zutylizować z pozostałymi 
odpadami domowymi.

Aby zapewnić bezpieczeństwo i prawidłowe 
działanie produktu, w celu wymiany lub 
wyjęcia akumulatora produkt należy przynieść 
do specjalnego punktu zbiórki odpadów lub 
centrum serwisowego (zobacz rysunek):



7

Po
ls

ki

PL

Należy zapoznać się z lokalnymi przepisami 
dotyczącymi utylizacji baterii. Prawidłowa 
utylizacja baterii pomaga zapobiegać 
zanieczyszczeniu środowiska naturalnego oraz 
utracie zdrowia.
 
Uwagi dla użytkowników na terenie Unii 
Europejskiej
Niniejszy produkt jest zgodny z przepisami Unii 
Europejskiej dotyczącymi zakłóceń radiowych.
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2 Nowe 
urządzenie 
SPARK

Korzystaj z urządzenia SPARK, aby
odtwarzać pliki audio• 
wyświetlanie zdjęć• 
słuchanie radia FM• 
nagrywanie• 

Zawartość opakowania
Sprawdź, czy opakowanie zawiera następujące 
elementy:
Odtwarzacz

Słuchawki

Skrócona instrukcja obsługi

Philips GoGear audio player

Quick start guide

Uwaga

Obrazki są przykładowe. Firma Philips zastrzega  •
sobie prawo do zmiany koloru i kształtu 
produktu, bez wcześniejszego powiadomienia.
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3 Czynności 
wstępne

Opis przycisków sterujących i 
połączeń

a MIC mikrofon
b OPTIONS dostęp do opcji menu
c wyświetlacz
d p gniazdo słuchawek
e y włączanie i wyłączanie 

urządzenia SPARK
blokowanie / 
odblokowywanie wszystkich 
klawiszy (oprócz klawiszy 
głośności)

f złącze mini USB

g 2 odtwarzanie/wstrzymywanie 
/ nagrywanie
potwierdzanie wyboru
przechodzenie do 
następnego ekranu

h RESET resetuj
i 3 / 4 naciśnięcie: przechodzenie 

wstecz/do przodu / w 
górę/w dół
naciśnięcie i przytrzymanie: 
szybkie przewijanie do tyłu/
do przodu / w górę/w dół

j naciśnięcie: przejście do 
poprzedniego ekranu
naciśnięcie i przytrzymanie: 
powrót do głównego menu

k – VOL + naciśnięcie: zwiększanie/
zmniejszanie poziomu 
głośności
naciśnięcie i przytrzymanie: 
szybkie zwiększanie i 
zmniejszanie poziomu 
głośności

Przestroga

Słuchanie głośnych dźwięków przez dłuższy  •
czas może być szkodliwe.

Możliwe jest ustawienie poziomu głośności 
urządzenia SPARK tak, aby ograniczyć jej 
maksymalny poziom.
1 W menu głównym wybierz kolejno 

[Ustawienia]>[Ustawienia dźwięku] > 
[Limit głośności].

2 Ustaw poziom, korzystając z przycisków 
regulacji głośności  / .

3 Naciśnij przycisk , aby potwierdzić.
Po wyregulowaniu limitu głośności  »
urządzenia SPARK nie ma możliwości 
jej dalszego zwiększania, nawet za 
pomocą przycisku .
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Aby ponownie uaktywnić maksymalną głośność:
1 Wybierz kolejno opcje [Ustawienia] > 

[Ustawienia dźwięku] >[Limit głośności].
2 Ustaw limit głośności na maksymalny.
3 Naciśnij przycisk , aby potwierdzić.

Opis głównego menu

Menu Tryb Funkcja
Muzyka odtwarzanie cyfrowych 

ścieżek audio
Zdjęcia wyświetlanie zdjęć
Radio FM słuchanie radia FM
Nagrania tworzenie lub słuchanie 

nagrań
Widok 
folderów

przeglądanie plików w 
folderach

Personalizuj personalizacja wyglądu 
urządzenia SPARK

Ustawienia konfiguracja ustawień 
urządzenia SPARK

Teraz 
odtwarzane

wyświetlenie aktualnego 
ekranu odtwarzania

Podłączanie i ładowanie
Urządzenie SPARK ma wbudowany akumulator, 
który można ładować po podłączeniu do portu 
USB komputera (przewód USB dołączony do 
zestawu).

Uwaga

Po podłączeniu urządzenia SPARK do  •
komputera zostanie wyświetlony monit o 
wybranie opcji:

 • [Ładowanie i przesyłanie] lub [Ładowanie i 
odtwarzanie].
Urządzenie SPARK automatycznie wybierze  •
opcję [Ładowanie i przesyłanie], jeśli nie 
zostanie wybrana inna opcja.

Podłączanie urządzenia SPARK do 
komputera
1 Podłącz wtyczkę USB dołączonego 

przewodu USB do dodatkowego portu 
USB w komputerze.

2 Podłącz małą wtyczkę przewodu USB do 
małego gniazda USB urządzenia SPARK.

3 Włącz komputer.
Rozpocznie się ładowanie urządzenia  »
SPARK.

Install Philips Songbird for the first 
time
 
When you connect SPARK to the PC for the 
first time, a pop-up window appears:
1 Select Install Philips Songbird.
2 Follow the on-screen instructions to 

complete the installation.

Uwaga

The installation requires you to agree to the  •
license terms.

 
If the pop-up window is not displayed 
automatically:
1 Select My Computer (Windows XP / 

Windows 2000) / Computer (Windows 
Vista / Windows 7).

2 Right click on the Philips GoGear SPARK 
icon.

3 Select Install Philips Songbird (Setup.
exe).

4 Follow the on-screen instructions to 
complete the installation.

Uwaga

The installation requires you to agree to the  •
license terms.
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Ponowna instalacja programu Philips 
Songbird (po przeprowadzeniu 
pierwszej instalacji)
Uwaga!
Instalator programu Philips Songbird jest 
załadowany fabrycznie w urządzeniu SPARK. 
W celu zwolnienia miejsca na zawartość 
multimedialną w urządzeniu SPARK plik 
instalatora jest automatycznie kasowany 
podczas pierwszej instalacji. 
Aby zainstalować program po 
przeprowadzeniu pierwszej instalacji, wykonaj 
poniższe czynności:
1 Podłącz urządzenie SPARK do 

komputera.
2 Upewnij się, że komputer jest podłączony 

do Internetu, a następnie otwórz 
Eksplorator Windows.

3 W Eksploratorze Windows kliknij 
prawym przyciskiem myszy urządzenie 
SPARK, a następnie wybierz opcję 
instalacji programu Philips Songbird.

Komputer pobierze plik instalatora z  »
Internetu.

4 Postępuj według instrukcji na ekranie, aby 
zakończyć instalację.

Wskaźnik poziomu naładowania 
akumulatora
Na wyświetlaczu są wyświetlane następujące 
przybliżone poziomy naładowania 
akumulatora:

100% 75% 50% 25% 0%

Migające ostrzeżenie wskazuje, że  »
poziom naładowania akumulatora jest 
niski. Odtwarzacz zachowuje wszystkie 
ustawienia i wyłącza się w ciągu 60 
sekund.

Uwaga

Akumulatory mają ograniczoną liczbę możliwych  •
cykli ładowania. Żywotność akumulatora 
oraz liczba cykli ładowania zależą od sposobu 
używania i zastosowanych ustawień.
Wyłączenie się animacji i pojawienie się  •
ikony  oznacza, że proces ładowania został 
zakończony.

Wskazówka

W celu zaoszczędzenia ładunku baterii i  •
wydłużenia czasu odtwarzania urządzenia 
SPARK przejdź kolejno do  > [Ustawienia 
wyświetlania] > [Wyłącznik ekranu] i upewnij 
się, że wybrano najkrótszy czas.

Program załadowany w 
urządzeniu SPARK
SPARK zawiera także następujące 
oprogramowanie: 
• Philips Songbird (umożliwia aktualizację 

oprogramowania sprzętowego 
urządzenia SPARK i przesyłanie plików 
multimedialnych).
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Pliki załadowane w 
urządzeniu SPARK
Urządzenie SPARK zawiera następujące pliki:

Instrukcja obsługi• 
Często zadawane pytania• 
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4 Aktualizacja 
oprogramowa-
nia urządzenia 
SPARK

Pracą urządzenia SPARK steruje wewnętrzny 
program nazywany oprogramowaniem 
sprzętowym. Po pewnym czasie od zakupu 
urządzenia SPARK mogą pojawić się nowe 
wersje tego oprogramowania.
Program Philips Songbird umożliwia 
sprawdzenie za pomocą komputera, czy 
w Internecie jest dostępna aktualizacja 
oprogramowania sprzętowego.
Zainstaluj na komputerze program 
Philips Songbird (patrz rozdział Instalacja 
oprogramowania) i postępuj według instrukcji, 
aby dokonać aktualizacji (patrz rozdział Ręczna 
weryfikacja / aktualizacja oprogramowania 
sprzętowego).

Uwaga

Aktualizacja oprogramowania sprzętowego nie  •
ma wpływu na utwory muzyczne.

Ręczna weryfikacja / 
aktualizacja oprogramowania 
sprzętowego
1 Upewnij się, że komputer ma połączenie 

z Internetem.
2 Podłącz urządzenie SPARK do komputera 

(szczegółowe instrukcje można znaleźć w 
części Podłączanie i ładowanie).

3 W komputerze kliknij kolejno: Start > 
Programy > Philips > Philips Songbird, 
aby uruchomić program Philips Songbird.

4 Wybierz kolejno opcje Tools > Updates 
(Narzędzia > Aktualizacje).

Program  » Philips Songbird sprawdzi 
w Internecie dostępność nowych 
wersji oprogramowania sprzętowego i 
zainstaluje je, jeśli będą dostępne.

5 Postępuj według instrukcji na ekranie, 
aby zaktualizować oprogramowanie 
sprzętowe urządzenia SPARK.

6 Poczekaj na zakończenie aktualizacji, a 
następnie odłącz urządzenie SPARK od 
komputera.

Urządzenie SPARK samoczynnie  »
uruchomi się ponownie po 
zaktualizowaniu oprogramowania, po 
czym będzie gotowe do użytku.
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5 Włączanie i 
wyłączanie 
urządzenia 
SPARK

1 Aby włączyć lub wyłączyć urządzenie, 
przesuń i przytrzymaj przycisk  przez 
około 2 sekundy.

Automatyczny tryb 
wyłączania
W urządzeniu SPARK jest dostępny 
automatyczny tryb wyłączania umożliwiający 
oszczędzanie energii akumulatora. 
Po 10 minutach bezczynności (nie jest 
odtwarzana muzyka, nie jest naciśnięty żaden 
przycisk) urządzenie SPARK wyłącza się.
1 Przesuń i przytrzymaj przycisk  przez 

około 2 sekundy, aby ponownie włączyć 
urządzenie SPARK.

Blokada przycisków
Urządzenie SPARK jest wyposażone w 
blokadę przycisków zabezpieczającą przed 
przypadkowym naciśnięciem.
1 Aby zablokować przyciski podczas 

odtwarzania, przesuń suwak do pozycji .
Wszystkie przyciski, z wyjątkiem  »
przycisków głośności, zostaną 
zablokowane, zaś na ekranie pojawi się 
ikona blokady.

2 Aby ponownie odblokować przyciski, 
przesuń suwak do pozycji środkowej.
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6 Philips Songbird
SPARK zawiera program Philips Songbird. 
Program Philips Songbird umożliwia:

zakup nowych multimediów (muzyki i • 
filmów) w Internecie
tworzenie biblioteki plików • 
multimedialnych
zarządzanie biblioteką plików • 
multimedialnych
odtwarzanie muzyki i filmów• 
synchronizację multimediów z • 
urządzeniem SPARK

Po pierwszym uruchomieniu programu Philips 
Songbird wybierz jedną z następujących opcji, 
aby zaimportować pliki multimedialne do 
biblioteki plików multimedialnych programu 
Songbird:

Zaimportowanie biblioteki programu • 
iTunes.
Wyszukanie plików multimedialnych • 
w określonych katalogach. (Można 
wybrać opcję śledzenia folderu, tak 
aby pliki dodawane lub usuwane z tego 
folderu były automatycznie dodawane 
lub usuwane z biblioteki plików 
multimedialnych programu Songbird).

Tworzenie biblioteki plików 
multimedialnych
Użyj jednej lub kilku z poniższych opcji, aby 
utworzyć bibliotekę plików multimedialnych za 
pomocą programu Songbird:

Zgrywanie zawartości płyty CD
Domyślnie program Philips Songbird instaluje 
następujące dodatki, które są wymagane do 
zgrywania zawartości płyty CD:

CD Rip Support• 
Gracenote Metadata Lookup Provider• 

Ustawienia opcji zgrywania zawartości 
płyty CD
1 Uruchom program Songbird w 

komputerze.
2 Wybierz kolejno: Tools (Narzędzia) > 

Options... (Opcje...).
3 Wybierz kartę CD Rip (Zgrywanie 

płyty CD), a następnie wybierz opcje 
zgrywania zawartości płyty CD.

4 Kliknij przycisk OK, aby potwierdzić.

Importowanie plików multimedialnych 
z katalogu
Poniższe czynności przedstawiają sposób 
importowania plików multimedialnych (muzyki 
i filmów) przechowywanych w komputerze 
lub w sieci komputerowej:
1 Uruchom program Songbird w 

komputerze.
2 Na pasku narzędzi programu Songbird 

kliknij opcję File (Plik), a następnie 
wybierz opcję Import Media (Importuj 
multimedia).

3 Wybierz pliki multimedialne (muzykę lub 
filmy), a następnie kliknij przycisk OK.

Dodane pliki multimedialne zostaną  »
wyświetlone w bibliotece plików 
multimedialnych.

Wskazówka

Jeśli zostanie wybrany folder zawierający pliki  •
muzyczne lub filmy, program przeskanuje 
folder i doda wszystkie zawarte w nim pliki 
muzyczne lub filmy do biblioteki plików 
multimedialnych (zduplikowane tytuły są 
ignorowane).
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Import media from iTunes
1 Uruchom program Songbird w 

komputerze.
2 Select Tools > Options....
3 On the Songbird toolbar, select the 

Media Importer tab, then iTunes Import/
Export.

4 Verify your library location and options.
5 Select Import Library.

The software imports the iTunes  »
library into Songbird.

Export media to iTunes
1 Uruchom program Songbird w 

komputerze.
2 Select Tools > Options....
3 On the Songbird toolbar, select the 

Media Importer tab, then iTunes Import/
Export.

4 Verify your library location and options.
5 Select Export Library.

The software exports the library from  »
Songbird to iTunes.

Pobieranie zawartości ze źródeł 
internetowych
Zawartość można kupować w źródłach 
internetowych, takich jak:

7-digital• 
Sprawdź dane techniczne urządzenia SPARK, 
aby upewnić się, jakie usługi są dostępne.

Importowanie nagrań z urządzenia 
SPARK
1 Uruchom program Songbird w 

komputerze.
2 Na pasku narzędzi programu Songbird 

kliknij opcję File (Plik), a następnie 
wybierz opcję Import Media (Importuj 
multimedia).

3 Wybierz nagrania na urządzeniu SPARK i 
kliknij przycisk OK.

Wybrane nagrania zostaną  »
wyświetlone w bibliotece multimediów.

Wskazówka

Jeśli zostanie wybrany folder zawierający  •
nagrania, program przeskanuje folder i doda 
wszystkie zawarte w nim nagrania do biblioteki 
(zduplikowane tytuły są ignorowane).

Przeglądanie biblioteki plików 
multimedialnych
Biblioteka plików multimedialnych programu 
Songbird ma następującą strukturę:

a Panel odtwarzacza (w tym miejscu 
wyświetlany jest SPARK)

b Panel biblioteki (w tym miejscu 
wyświetlana jest zawartość biblioteki)
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c Panel usług (w tym miejscu można znaleźć 
dodatkowe informacje o zawartości, takie 
jak listy odtwarzania)

d Panel informacji (w tym miejscu można 
znaleźć informacje o wybranych opcjach)

Ustawianie zarządzania multimediami 
przez program Songbird
1 Uruchom program Songbird w 

komputerze.
2 Wybierz kolejno: Tools (Narzędzia) > 

Options… (Opcje). 
3 Na pasku narzędzi programu Songbird 

wybierz kartę Manage Files (Zarządzanie 
plikami).

4 Zaznacz opcję Allow Songbird to manage 
my files (Zezwól programowi Songbird 
na zarządzanie moimi plikami).

5 Ustaw opcje porządkowania 
multimediów.

Usuwanie plików multimedialnych 
z biblioteki plików multimedialnych 
programu Songbird
1 W bibliotece programu Songbird kliknij 

wybrany plik multimedialny prawym 
przyciskiem myszy, a następnie wybierz 
polecenie Remove (Usuń).

2 W oknie monitu kliknij przycisk Remove 
(Usuń), aby potwierdzić usunięcie pliku.

Wybrany plik zostanie usunięty z  »
biblioteki i wszystkich list odtwarzania. 
(Domyślnie plik jest tylko „usuwany”, 
a nie „kasowany”. Plik multimedialny 
ciągle istnieje w tym samym miejscu na 
komputerze lub w sieci komputerowej).

Wskazówka

Aby wybrać wiele plików w komputerze (PC),  •
naciśnij i przytrzymaj klawisz Ctrl.
Aby wybrać wiele sąsiadujących plików, naciśnij  •
i przytrzymaj klawisz Shift .

Usuwanie pliku
Aby usunąć pliki multimedialne, korzystając z 
Eksploratora Windows:
1 Po podłączeniu urządzenia SPARK 

do portu USB komputera otwórz 
Eksplorator Windows.

2 Znajdź folder z plikami multimedialnymi w 
urządzeniu SPARK.

3 Skasuj plik multimedialny, tak jak robisz to 
w komputerze.

Śledzenie folderu przez program 
Songbird
Program Songbird

można ustawić w celu monitorowania • 
zawartości folderu oraz
dodawania lub usuwania multimediów z • 
biblioteki zgodnie z zawartością folderu.

1 Uruchom program Songbird w 
komputerze.

2 Wybierz kolejno: Tools (Narzędzia) > 
Options... (Opcje...).

3 Na pasku narzędzi programu Songbird 
wybierz kartę Media Importer (Importer 
multimediów), a następnie wybierz opcję 
Watch Folders (Śledź foldery).

4 Wybierz folder, w którym program 
Songbird ma śledzić zmiany.

Wybrany folder będzie śledzony,  »
a program Songbird będzie 
dopasowywał zawartość biblioteki do 
zawartości tego folderu.
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Pobieranie okładek albumów
Wybierz jedną z następujących opcji, aby 
pobierać okładki albumów:
1 Uruchom program Songbird w 

komputerze.
Na pasku narzędzi programu • 
Songbird wybierz kolejno opcje 
Tools > Get Album Artwork 
(Narzędzia > Pobierz okładkę 
albumu).

Jeśli nie wybrano żadnych tytułów,  »
program Songbird pobierze okładki dla 
wszystkich tytułów w bibliotece.
Kliknij prawym przyciskiem myszy • 
wybrane tytuły.

Program Songbird pobierze okładki dla  »
wszystkich wybranych tytułów.

Listy odtwarzania
Domyślnie program Philips Songbird instaluje 
następujące dodatki, które są wymagane do 
zgrywania zawartości płyty CD:

CD Rip Support• 
Gracenote Metadata Lookup Provider• 

Tworzenie listy odtwarzania
1 Uruchom program Songbird w 

komputerze.
2 Wybierz jedną z następujących opcji, aby 

utworzyć nową listę odtwarzania:
Na pasku narzędzi programu • 
Songbird wybierz kolejno opcje File 
> New Playlist (Plik > Nowa lista 
odtwarzania).
Kliknij prawym przyciskiem myszy • 
pasek boczny po prawej stronie 
i wybierz polecenie New Playlist 
(Nowa lista odtwarzania).
Kliknij symbol • + u dołu panelu usług 
po lewej stronie.

W panelu usług zostanie wyświetlona  »
nowa lista odtwarzania.

3 Wprowadź nazwę nowej listy odtwarzania.

Dodawanie tytułów do listy 
odtwarzania
1 Uruchom program Songbird w 

komputerze.
2 Wybierz jeden lub więcej tytułów.
3 Wybierz jedną z następujących opcji, 

aby dodać wybrane tytuły do listy 
odtwarzania:

Przeciągnij i upuść wybrane tytuły na • 
listę odtwarzania w okienku usług.
Kliknij prawym przyciskiem myszy • 
wybrany element i wybierz 
polecenie Add to Playlist (Dodaj do 
listy odtwarzania) > nazwa_listy_
odtwarzania.

Wszystkie wybrane tytuły zostaną  »
dodane do listy odtwarzania.
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Usuwanie tytułów z listy odtwarzania
1 Uruchom program Songbird w 

komputerze.
2 Wybierz listę odtwarzania.
3 Kliknij prawym przyciskiem myszy tytuł, 

który chcesz usunąć, a następnie kliknij 
polecenie Remove (Usuń).

Wybrany tytuł zostanie usunięty z listy  »
odtwarzania.

Zmiana wyglądu biblioteki 
programu Songbird
Istnieje możliwość zmiany wyglądu i schematu 
kolorów biblioteki programu Songbird. Jest to 
nazywane „zmianą piórek”. Nowe piórka są 
instalowane i zarządzane w podobny sposób jak 
dodatki.
Znajdowanie nowych piórek
1 Uruchom program Songbird w 

komputerze.
2 Na pasku narzędzi programu Songbird 

wybierz kolejno opcje View > Feathers > 
Get More Feathers (Widok > Piórka > 
Pobierz więcej piórek).

Program wyszuka nowe piórka. »

Postępuj zgodnie z instrukcjami  »
wyświetlanymi na ekranie, aby 
zainstalować nowe piórka.

Sformatuj urządzenie SPARK 
(usuwa całą muzykę oraz 
dane)
Philips Songbird ma funkcję formatowania, przy 
użyciu której można sformatować urządzenie 
SPARK i skasować wszystkie pliki z pamięci 
wewnętrznej.

Przestroga

Wykonaj poniższe czynności, aby skasować  •
wszystkie pliki przechowywane w urządzeniu 
SPARK.

1 Zainstaluj na komputerze program 
Philips Songbird (patrz rozdział Instalacja 
oprogramowania), a następnie uruchom 
go.

2 Na panelu odtwarzacza Philips Songbird 
kliknij pozycję SPARK.

3 W oknie biblioteki kliknij zakładkę Tools 
(Narzędzia).

4 W oknie narzędzi kliknij opcję Format 
device (Formatuj urządzenie).

5 Postępuj według instrukcji na ekranie, aby 
zakończyć procedurę naprawczą.
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Napraw urządzenie SPARK 
(przywracanie ustawień 
fabrycznych)
Philips Songbird ma funkcję naprawy, przy 
użyciu której można przywrócić ustawienia 
fabryczne urządzenia SPARK. 
Przed wykonaniem poniższych czynności, 
jeśli to możliwe, zrób kopie zapasowe plików 
przechowywanych w urządzeniu SPARK.

Przestroga

Wykonanie poniższych czynności spowoduje  •
usunięcie wszystkich plików zapisanych 
w urządzeniu SPARK oraz przywrócenie 
ustawień fabrycznych.

1 Zainstaluj na komputerze program 
Philips Songbird (patrz rozdział Instalacja 
oprogramowania), a następnie uruchom 
go.

2 Na pasku menu programu Philips 
Songbird (u góry), kliknij rozwijane menu 
Tools (Narzędzia) i wybierz polecenie 
Repair My SPARK (Napraw mój 
odtwarzacz).

3 Postępuj według instrukcji na ekranie, aby 
zakończyć procedurę naprawczą.
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7 Muzyka

Słuchanie muzyki
1 W menu głównym wybierz opcję , aby 

przejść w tryb muzyczny.
2 Poruszając się po podmenu, wybierz 

utwór muzyczny.
3 Naciśnij przycisk , aby odtworzyć.

Naciśnij przycisk • , aby wstrzymać.
Naciśnij przycisk • OPTIONS, aby 
wyświetlić więcej opcji muzycznych.
Naciśnij przycisk • , aby wrócić do 
poprzedniego poziomu menu.
Naciśnij przycisk • , aby powrócić do 
głównego menu.

Wyszukiwanie muzyki
W menu głównym wybierz opcję , aby przejść 
w tryb muzyczny.
W menu urządzenia SPARK znajdują się 
następujące opcje:
[Wszystkie utwory]

Utwory w kolejności alfabetycznej• 
[Wykonawcy]

Wykonawcy w kolejności alfabetycznej• 
Albumy w kolejności alfabetycznej• 
Utwory w kolejności według albumu• 

[Albumy]
Albumy w kolejności alfabetycznej• 
Utwory w kolejności według albumu• 

[Gatunki]
Gatunki w kolejności alfabetycznej• 
Wykonawcy w kolejności alfabetycznej• 
Albumy w kolejności alfabetycznej• 
Utwory w kolejności według albumu• 

[Listy odtwarzania]
• [Playlist-on-the-go]

Utwory w kolejności listy odtwarzania• 
[Książki audio]*

Tytuły książek w kolejności • 
alfanumerycznej

Uwaga

* Książki audio można zakupić w sklepach  •
internetowych, np. audible.com. 
SPARK obsługuje książki audio, takie jak pliki  •
muzyczne. 

Usuwanie aktualnie odtwarzanego 
pliku muzycznego
Aby usunąć aktualnie odtwarzany plik 
muzyczny:
1 Podczas odtwarzania pliku muzycznego 

naciśnij przycisk OPTIONS.
2 Wybierz tę opcję, aby usunąć utwór.
3 Wybierz opcję [Tak], aby potwierdzić 

usunięcie.

Usuwanie jednego lub kilku utworów 
muzycznych
Użyj programu Philips Songbird, aby 
zsynchronizować pliki multimedialne.
Plik muzyczny można również usunąć, 
korzystając z Eksploratora Windows:
1 Podłącz urządzenie SPARK do 

komputera.
2 W Eksploratorze Windows znajdź plik z 

muzyką w urządzeniu SPARK.
3 Usuń plik muzyczny tak, jak zazwyczaj 

robisz to na komputerze.

Uwaga

Możesz również wybrać opcję  •  z menu 
głównego i odszukać pliki z muzyką w widoku 
folderu.
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8 Książki audio
SPARK obsługuje książki w formacie audio. 
Aby używać tej funkcji, pobierz program 
AudibleManager ze strony internetowej audible.
com. Program AudibleManager pozwala na 
zarządzanie cyfrową zawartością książek audio.
Przejdź na stronę audible.com i zarejestruj się. 
Instrukcje wyświetlane na ekranie przeprowadzą 
Cię przez proces pobierania programu 
AudibleManager.

Dodawanie książek audio do 
urządzenia SPARK
• Ważne: Urządzenie SPARK obsługuje 

książki audio w formacie  lub .
1 Uruchom w komputerze program 

AudibleManager.
2 Postępuj zgodnie z instrukcjami 

dostępnymi w Internecie i pobierz książki 
audio w formacie  lub w formacie .

3 Postępuj zgodnie z instrukcjami 
wyświetlanymi przez program 
AudibleManager, aby aktywować 
urządzenie SPARK pod kątem pobranych 
książek audio. 

4 Postępuj zgodnie z instrukcjami 
wyświetlanymi przez program 
AudibleManager, aby przesłać książki 
audio do urządzenia SPARK.

Uwaga

Urządzenie SPARK może odtwarzać tylko  •
te książki audio, pod kątem których zostało 
aktywowane.

Funkcje odtwarzania książek 
audio
Urządzenie SPARK udostępnia następujące 
funkcje odtwarzania książek audio:

Cel Czynność
Odtwarzanie/
wstrzymanie

Naciśnij przycisk 

Przejście do początku 
kolejnej części/rozdziału

Naciśnij przycisk 

Powrót do początku 
bieżącej części/rozdziału

Naciśnij przycisk 

Szybkie przeskakiwanie 
do przodu książki

Naciśnij i przytrzymaj 
przycisk 

Szybkie przeskakiwanie 
do tyłu książki

Naciśnij i przytrzymaj 
przycisk 

Przejście do menu opcji Naciśnij przycisk 
OPTIONS

Powrót do menu 
przeglądania zawartości

Naciśnij przycisk 

Zwiększanie/
zmniejszanie poziomu 
głośności

Naciśnij przycisk  
VOL 

Wskazówka

Odtwarzanie można wznowić po wyjściu z  •
ekranu książek audio (patrz część Wznawianie 
odtwarzania w tej instrukcji obsługi).

Wybór książki audio według 
tytułu
1 W menu głównym wybierz opcję , aby 

przejść w tryb muzyczny.
2 Naciśnij przycisk  lub , a następnie 

przycisk , aby wybrać opcję Książki 
audio.

3 Naciśnij przycisk  lub , aby wybrać 
tytuł, a następnie naciśnij przycisk , aby 
uruchomić odtwarzanie.

Aby zakończyć, naciśnij przycisk  » .
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9 Zdjęcia

Dodawanie zdjęć do 
urządzenia SPARK
1 Podłącz urządzenie SPARK do 

komputera.
2 W Eksploratorze Windows utwórz 

foldery w urządzeniu SPARK.
3 Przeciągnij i upuść zdjęcia we właściwym 

miejscu, aby je posortować w foldery.

Wyświetlanie zdjęć
1 W menu głównym wybierz opcję , aby 

przejść w tryb zdjęć.
2 Poruszając się po podmenu, wybierz 

zdjęcie.
3 Naciśnij przycisk , aby wyświetlić 

wybrane zdjęcie w trybie 
pełnoekranowym.

Naciśnij przycisk • , aby wrócić do 
poprzedniego poziomu menu.
Naciśnij przycisk • , aby powrócić do 
głównego menu.

Wyświetlanie pokazu slajdów
W trybie  możliwe jest wyświetlanie obrazów 
w formie pokazu slajdów:
1 Naciśnij przycisk , aby rozpocząć pokaz 

slajdów.

Wskazówka

Możesz zmienić ustawienia pokazu slajdów w  •
menu ustawień .

Kasowanie aktualnie 
wyświetlanego zdjęcia
Aby usunąć aktualnie wyświetlane zdjęcie:
1 Gdy zdjęcie jest wyświetlone, naciśnij 

przycisk OPTIONS.
2 Wybierz tę opcję, aby usunąć zdjęcie.
3 Wybierz opcję [Tak], aby potwierdzić 

usunięcie.

Usuwanie jednego lub kilku 
zdjęć
Usuń zdjęcia, korzystając z Eksploratora 
Windows w komputerze:
1 Podłącz urządzenie SPARK do 

komputera.
2 W Eksploratorze Windows znajdź folder 

ze zdjęciami w urządzeniu SPARK.
3 Usuń zdjęcia tak, jak zazwyczaj robisz to 

na komputerze.

Uwaga

Możesz również wybrać opcję  •  z menu 
głównego i odszukać pliki w widoku folderu.
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10 Radio (tylko 
wybrane 
wersje!)

Słuchanie radia FM
1 W menu głównym wybierz opcję , aby 

przejść w tryb radia.
Przewód do słuchawek służy jako  »
antena FM. 

Wskazówka

Radio wyłącza się po przełączeniu urządzenia  •
do innego trybu lub po wyłączeniu urządzenia 
SPARK.

Ręczne dostrajanie stacji 
radiowej
W trybie  istnieje możliwość ręcznego 
dostrojenia stacji radiowej:
1 Aby kontynuować wyszukiwanie 

silniejszego sygnału, naciśnij i przytrzymaj 
przyciski  / .

2 Częstotliwość radia można dostroić za 
pomocą przycisków  / .

Automatyczne dostrajanie 
zaprogramowanej stacji 
radiowej
Funkcja automatycznego dostrajania urządzenia 
SPARK pomaga wyszukać stacje radiowe i 
zapisać je pod odpowiednim numerem.
1 Podłącz słuchawki.
2 W menu głównym wybierz opcję , aby 

przejść w tryb radia.
3 Naciśnij przycisk OPTIONS, aby 

wyświetlić menu opcji.
4 Wybierz opcję [Strojenie automatyczne].

Odbiornik przeprowadzi automatyczne  »
strojenie stacji radiowych i zapisze 20 
najsilniejszych częstotliwości w postaci 
dostępnych stacji.
Aby zatrzymać automatycznie • 
strojenie, naciśnij przycisk .
Aby wyjść z trybu radia, naciśnij • 
i przytrzymaj przez 2 sekundy 
przycisk .

Odtwarzanie 
zaprogramowanej stacji 
radiowej
1 W trybie  wybierz zaprogramowaną 

stację.
2 Aby zmienić stację, naciśnij przycisk  lub 

.
3 Aby wyszukać następny, silniejszy sygnał, 

naciśnij i przytrzymaj przez 2 sekundy 
przycisk  lub .

Aby powrócić do menu głównego, • 
naciśnij i przytrzymaj przycisk  
przez 2 sekundy.

Uwaga

Aby odtwarzać stacje radiowe, najpierw należy  •
je zaprogramować.
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11 Nagrania

Nagrywanie audycji 
radiowych FM (tylko wybrane 
wersje!)
1 W trybie radia  naciśnij przycisk 

OPTIONS, a następnie wybierz opcję 
[Rozp. nagrywanie radia FM].

Naciśnij przycisk • ; , aby wstrzymać.
2 Naciśnij przycisk , aby zatrzymać.
3 Naciśnij przycisk 2, aby zapisać nagranie 

lub naciśnij przycisk  w celu anulowania.
Nagrania są zapisywane w  »
odtwarzaczu. (Format nazwy pliku: 
FMRECXXX.MP3, gdzie XXX oznacza 
numer nagrania wygenerowany 
automatycznie).

Wskazówka

Nagrania znajdują się w obszarze  • [Biblioteka 
nagrań] > [Radio FM].

Nagrywanie dźwięku / głosu
Tutaj dowiesz się, jak można nagrywać dźwięk 
lub głos, korzystając z wbudowanego mikrofonu 
(aby odszukać lokalizację wbudowanego 
mikrofonu, patrz część Opis):
1 W menu głównym wybierz kolejno  > 

[Rozp. nagryw. not. głos.].
Naciśnij przycisk • , aby wstrzymać.

2 Naciśnij przycisk , aby zatrzymać.
3 Naciśnij przycisk , aby zapisać nagranie 

lub naciśnij przycisk  w celu anulowania.
Nagrania są zapisywane w  »
odtwarzaczu. (Format nazwy pliku: 
VOICEXXX.MP3, gdzie XXX oznacza 
numer nagrania wygenerowany 
automatycznie).

Wskazówka

Nagrania znajdują się w obszarze  • [Biblioteka 
nagrań] > [Głos].

Słuchanie nagrań
Słuchanie nagrań radia FM*:
1 W menu  wybierz kolejno [Biblioteka 

nagrań] > [Radio FM].
2 Wybierz nagranie.
3 Naciśnij przycisk 2, aby odtworzyć 

nagranie.

Uwaga

*Nagrywanie audycji radiowej jest dostępne  •
tylko w przypadku niektórych modeli 
urządzenia. Sprawdź w menu ekranowym 
urządzenia SPARK, które funkcje są dostępne 
w tym modelu.
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Słuchanie nagrań głosu lub dźwięku:
1 W menu  wybierz kolejno [Biblioteka 

nagrań] > [Głos].
2 Wybierz nagranie.
3 Naciśnij przycisk , aby odtworzyć 

nagranie.

Przesyłanie nagrań do 
komputera
Użyj programu Philips Songbird, aby 
zsynchronizować pliki multimedialne.
Można również przesłać nagrania, korzystając z 
Eksploratora Windows.
1 Podłącz urządzenie SPARK do 

komputera.
2 W Eksploratorze Windows otwórz 

urządzenie SPARK.
3 Wybierz folder Nagrania > Głos lub 

Radio FM*.
4 Skopiuj i wklej wybrane nagrania 

do określonego katalogu na dysku 
komputera.

Uwaga

*Nagrywanie audycji radiowej jest dostępne  •
tylko w przypadku niektórych modeli 
urządzenia. Sprawdź w menu ekranowym 
urządzenia SPARK, które funkcje są dostępne 
w tym modelu.

Delete one or more 
recordings
This is how to delete recordings in Windows 
Explorer :
1 Connect SPARK to the computer.
2 In Windows Explorer, locate the folder 

Recordings > Voice or FM radio*.
3 Delete the recordings as you normally 

would on the computer.

Uwaga

* FM radio recording feature is available with  •
some versions only. Refer to the on-screen 
menu of SPARK to find out which features are 
available to you.

Przenoszenie danych za 
pomocą urządzenia SPARK
Aby zapisywać i przenosić pliki danych w 
urządzeniu SPARK:
1 Podłącz urządzenie SPARK do komputera 

(szczegółowe instrukcje można znaleźć w 
części Podłączanie i ładowanie).

2 Na ekranie komputera otwórz 
Eksplorator Windows,skopiuj pliki 
danych i wklej je do urządzenia SPARK.

Wskazówka

Aby przenieść dane z powrotem do  •
komputera lub usunąć je z urządzenia SPARK 
skorzystaj z komputera.
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12 Dostosowywa-
nie ustawień 
urządzenia 
SPARK

Tutaj dowiesz się, jak dostosować ustawienia 
urządzenia SPARK:
W menu głównym wybierz opcję , aby przejść 
w tryb dostosowywania ustawień.
W menu  wykonaj następujące czynności:
1 Za pomocą przycisków  /  wybierz 

opcję.
2 Naciśnij przycisk , aby zatwierdzić wybór 

i przejść do kolejnego poziomu (jeśli jest 
dostępny).

3 Naciśnij przycisk , aby powrócić do 
poprzedniego poziomu.

4 Naciśnij i przytrzymaj przycisk , aby 
zamknąć menu .

Wskazówka

Więcej opcji dotyczących ustawień można  •
znaleźć w części Konfiguracja ustawień .

W menu  dostępne są następujące opcje:

Motyw Czarny• 
Srebrny• 
Złoty• 

Wygaszacz 
ekranu

(brak)• 
Wyświetlacz wył. (domyślnie)• 
Własny pokaz slajdów...• 
Zegar cyfrowy• 
Okładka albumu• 
Tryb prezentacyjny• 

Ekran 
powitalny

Domyślnie• 
Wybierz zdjęcie...• 

Ekran 
końcowy

Domyślnie• 
Wybierz zdjęcie...• 
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13 Ustawienia
Tutaj dowiesz się, jak konfigurować urządzenie 
SPARK:
W menu głównym wybierz opcję , aby przejść 
w tryb ustawień.
W menu  wykonaj następujące czynności:
1 Za pomocą przycisków  /  wybierz 

opcję.
2 Naciśnij przycisk , aby zatwierdzić wybór 

i przejść do kolejnego poziomu (jeśli jest 
dostępny).

3 Naciśnij przycisk , aby powrócić do 
poprzedniego poziomu.

4 Naciśnij i przytrzymaj przycisk , aby 
zamknąć menu .

Wskazówka

Więcej opcji dotyczących ustawień  •
wyświetlacza można znaleźć w części 
Personalizuj .

W menu  dostępne są następujące opcje:

Ustawienia Menu opcji Opcje podmenu
Tryb odtwarzania Odtwarzaj muzykę... ...wszystkie utwory• 

...tego wykonawcy• 

...z tego albumu• 

...z tego gatunku• 
Powtarzaj Powtarzaj wył. (domyślnie)• 

Powtarzaj 1• 
Powtarzaj wszystko• 

Losowo Losowo wył. (domyślnie)• 
Losowo wszystkie• 

Ustawienia dźwięku FullSound* Wył.• 
Wł. (domyślnie)• 

Korektor** Wył. (domyślnie) • 
Rock• 
Funk• 
Hip-hop• 

Jazz• 
Klasyka• 
Techno• 
Niestandardowe• 

Limit głośności Wył. (domyślnie)• 
Ustaw• 

Wyłącznik czasowy Wył. (domyślnie)• 
Ustaw• 
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Ustawienia Menu opcji Opcje podmenu
Ustawienia wyświe-
tlania

Czas podświetlenia 15 sekund• 
30 sekund (domyślnie)• 
45 sekund• 
Zawsze wł.• 

Data i czas Ustawienia czasu Ustaw format godziny• 
Ustaw czas• 

Ustawienia daty Ustaw format daty• 
Ustaw datę• 

Ustawienia pokazu 
slajdów

Czas na slajd [x] sekund• 
Powtarzaj Wył.• 

Wł. (domyślnie)• 
Losowo Wył. (domyślnie)• 

Wł.• 
Język Czeski• 

Grecki• 
Angielski (domyślnie)• 
Duński• 
Niemiecki• 
Hiszpański• 
Francuski• 
Włoski• 
Węgierski• 
Holenderski• 

Norweski• 
Polski• 
Portugalski• 
Portugalski (Brazylia)• 
Rosyjski• 
Słowacki• 
Fiński• 
Szwedzki• 
Turecki• 
Chiński uproszczony• 

Chiński tradycyjny• 
Japoński• 
Koreański• 
Tajski (tylko wersja • 
/97)
Arabski (tylko wersja • 
/97)
Hebrajski (tylko wersja • 
/02)

Preferencyjne połą-
czenie z komputerem

MSC• 
MTP• 
Co to jest MSC?• 
Co to jest MTP?• 

Informacje Pojemność
Wolne miejsce
Wersję oprogramowania
Model
Strona pomocy

Prawne [legal information]
Formatuj urządzenie Wszystkie dane zostaną 

usunięte
Tak• 
Nie (domyślne)• 

Ustawienia fabryczne Przywrócić ustawienia 
fabryczne (pliki nie zmie-
nią się)?

Tak• 
Nie• 

* Aktywacja funkcji FullSound™ wyłącza 
korektor.
**Aktywacja korektora wyłącza funkcję 
FullSound™.
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14 Parametry 
techniczne

Zasilanie
Zasilanie: wbudowany polimerowy 
akumulator litowo-jonowy 220 mAh
Czas odtwarzania¹ (muzyka): 22 godziny
Oprogramowanie
Philips Songbird: umożliwia aktualizację 
oprogramowania sprzętowego i przesyłanie 
plików muzycznych
Połączenia
Słuchawki 3,5 mm 
Szybki interfejs USB 2.0
Dźwięk
Separacja kanałów: 45 dB
Pasmo przenoszenia: 80–18 000 Hz
Moc wyjściowa: 2 x 2,4 mW
Stosunek sygnału do szumu: > 84 dB
Odtwarzanie dźwięku
Obsługiwane formaty:
MP3, WAV, WMA, FLAC, APE

Szybkość kompresji Częstotliwości 
próbkowania

MP3:
8–320 kb/s i VBR 8, 11,025, 16, 

22,050, 32, 44,1, 
48 kHz

WMA:
5–320 kb/s 8, 11,025, 16, 

22,050, 32, 44,1, 
48 kHz

FLAC:
do 1,1 Mb/s 48 kHz
APE:
do 1,3 Mb/s 48 kHz

Wyświetlanie obrazu
Obsługiwane formaty:
JPG
BMP

Nośnik pamięci
Pojemność wbudowanej pamięci²:
SA2SPK02 2 GB NAND Flash
SA2SPK04 4 GB NAND Flash
SA2SPK08 8 GB NAND Flash
Przesyłanie plików muzycznych 
(synchronizacja)³
Philips Songbird
Przesyłanie plików muzycznych i zdjęć 
(„przeciągnij i upuść”)³
Eksplorator Windows
Wyświetlacz
Kolorowy wyświetlacz LCD, 128 x 128 pikseli

 

Uwaga

¹ Akumulatory mają ograniczoną liczbę  •
możliwych cykli ładowania. Żywotność 
akumulatora oraz liczba cykli ładowania 
zależą od sposobu używania i zastosowanych 
ustawień. 
² 1 GB = 1 miliard bajtów; faktyczna  •
pojemność pamięci jest mniejsza. Pełna 
pojemność pamięci może być niedostępna, 
ponieważ jej część jest zarezerwowana dla 
operacji i oprogramowania odtwarzacza. 
Pojemność przy założeniu 4-minutowej 
długości utworu i kompresji 128 kb/s w 
formacie MP3.
³ Prędkość przesyłania jest zależna od systemu  •
operacyjnego i konfiguracji oprogramowania.

Wymagania systemowe:
System operacyjny Windows® XP (SP3 • 
lub nowszy) / Vista / 7
Procesor Pentium III 800 MHz lub szybszy• 
520 MB RAM• 
500 MB wolnego miejsca na dysku • 
twardym
Połączenie z Internetem• 
Przeglądarka Windows® Internet • 
Explorer 6.0 lub nowsza
Port USB• 
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15 Słowniczek

D
Decybel (dB)
Jednostka miary służąca do wyrażania 
względnej różnicy mocy lub intensywności 
dźwięku.

F
FM (z ang. „Frequency Modulation” – 
modulacja częstotliwości)
W transmisji radiowej: metoda modulacji, w 
której częstotliwość napięcia sygnału nośnego 
różni się od częstotliwości napięcia modulacji.

FullSound
FullSound™ to innowacyjna technologia 
opracowana przez firmę Philips. Technologia 
FullSound™ w sposób wierny przywraca 
skompresowanej muzyce szczegóły 
dźwiękowe, ulepszając ją w celu zapewnienia 
pełnych doznań dźwiękowych bez 
jakichkolwiek zniekształceń. 

K
Kompresja
W przypadku dźwięku jest to proces 
tymczasowej lub trwałej redukcji danych 
audio w celu uzyskania bardziej wydajnego 
przechowywania lub transmisji. Tymczasowa 
redukcja rozmiaru pliku nazywana jest 
kompresją „bezstratną”, co oznacza, że nie 
dochodzi do utraty żadnych informacji. Trwała 
redukcja rozmiaru pliku (jak np. w przypadku 
plików MP3) nazywana jest kompresją 
„stratną” i pociąga za sobą porzucenie 
niepotrzebnych informacji, które zostają 
nieodwracalnie utracone.

Kompresja bezstratna
System redukcji liczby bitów danych (gęstość) 
w sygnale muzycznym bez zniekształcania 
oryginału.

L
LCD (Liquid Crystal Display) — wyświetlacz 
ciekłokrystaliczny
Prawdopodobnie najpowszechniejszy sposób 
wyświetlania informacji w postaci obrazu na 
sprzęcie elektronicznym innym niż komputer.

M
MP3
Format pliku z systemem kompresji danych 
dźwiękowych. MP3 to skrót od nazwy Motion 
Picture Experts Group 1 (lub MPEG-1) Audio 
Layer 3. Zastosowanie formatu MP3 pozwala 
umieścić na jednej płycie CD-R lub CD-RW 
około 10 razy więcej danych niż zawiera 
zwykła płyta CD. 

MSC (Mass Storage Class)
Klasa urządzenia pamięci masowej USB 
(inaczej: USB MSC albo UMS) to zbiór 
protokołów komunikacyjnych, które 
zapewniają interfejs urządzeniom pamięci. 
Urządzenia obsługujące ten standard 
nazywamy urządzeniami MSC (Klasa pamięci 
masowej).

MTP (Media Transfer Protocol)
Protokół MTP (Media Transfer Protocol) 
obsługuje przesyłanie plików muzycznych i 
wideo do przenośnych odtwarzaczy audio i 
wideo.
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O
Odpowiedź częstotliwościowa
Jest to zakres częstotliwości, jakie wytwarza 
głośnik, od częstotliwości najniższej do 
najwyższej. O ile normalny, optymalny zakres 
wynosi 20–20 000 Hz (herców), zdolność 
słyszenia przez poszczególne osoby jest często 
dużo bardziej ograniczona. Niemniej jednak 
dobry głośnik o pełnym zakresie odtwarza 
możliwie najwięcej dźwięków z tego zakresu, a 
tym samym wszelkie zmienności. Poszczególne 
sterowniki ograniczone są do odtwarzania 
jedynie tej części widma, do której zostały 
stworzone, a więc ich odpowiedź jest 
ograniczona. Jednakże jest to czynnik, który 
koniecznie należy wziąć pod rozwagę przy 
projektowaniu kompletnego systemu dźwięku.

P
Przepływność
Przepływność to liczba bitów przekazywanych 
lub przetwarzanych w danej jednostce czasu. 
Przepływność jest zazwyczaj mierzona jako 
wielokrotność bitów na sekundę (kilobity 
na sekundę: kb/s). Termin przepływność jest 
synonimem szybkości przesyłania danych (lub 
prościej — szybkości danych). 

S
SuperScroll
SuperScroll™ to dostępna w urządzeniu 
funkcja nawigacyjna wykorzystująca 
dwufunkcyjne przyciski wyszukiwania. 
Funkcja SuperScroll™ pozwala na łatwą 
kontrolę prędkości podczas przewijania 
dużych bibliotek w celu szybkiego znalezienia 
znajdujących się w nich elementów. Dłuższe 
naciśnięcie przycisku skutkuje większą 
prędkością przewijania.

Z
Zgraj (zgrywanie)
Korzystanie z programu, który kopiuje ścieżkę 
cyfrową z płyty kompaktowej i przenosi ją na 
dysk twardy komputera. Integralność danych 
zostaje zachowana, ponieważ sygnał nie 
przechodzi przez kartę dźwiękową komputera 
i nie trzeba go zamieniać na format analogowy. 
Transfer ścieżki cyfrowej do ścieżki cyfrowej 
powoduje utworzenie pliku WAV, który 
można zamienić na plik MP3.
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